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Learner
                  Resource

About this

 The purpose of this Learner Resource is to provide you with the 

underpinning knowledge required to assist you in completing 

assessment/s in Produce spreadsheets.

This Learner Resource also contains activities for you to test your 

knowledge and examples of skills application.

Throughout this Learner Resource, you will see icons that provide 

opportunities to test your knowledge and practice skills. This icon is 

displayed as follows:

Practice

This icon is used to highlight an ideal time to test your knowledge 
or practice what you have learnt.

How will I be assessed?

	➤ In order to achieve competency in Produce spreadsheets you 
will need to demonstrate the skills and knowledge required 
for the unit.

	➤ Your teacher will decide with you how and when you will be 
assessed.
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Copyright

Parts of this Learner Resource (text and graphics), may have been 
obtained from other sources and is reproduced within the laws and 
rights of copyright.

About this unit:
Welcome to the Learner Resource for Produce spreadsheets. In 

this Learner Resource you will be learning about the performance 
outcomes, skills and knowledge required to develop spreadsheets 
through the use of spreadsheet software.

It is suggested that to meet all the requirements of Produce 
spreadsheets youwill need to complete the following tasks:

	➤ Read the information contained in this Learner Resource.

	➤ Complete the activities.

	➤ Complete all the required assessment/s for this unit.

The topics in this Learner Resource are:

	➤ Select and prepare resources.

	➤ Create simple spreadsheets.

	➤ Produce simple charts.

	➤ Plan spreadsheet design.

	➤ Finalise spreadsheet.
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Introduction

  You are about to commence a 
vocational course where you will 
be required to demonstrate your 
competency in developing spread-
sheets through the use of 
spreadsheet software. This unit of 
competency covers the skills and 
knowledge required to create 
and design spreadsheets that 
encompass formatting, formulae 

and charts, working under minimal supervision.

Select and prepare resources

The first task you will need to consider when producing 
spreadsheets is how to select and prepare the resources you will 
need to successfully complete the task.

Occupational health and safety issues

The ergonomic requirements of the individual employee is a sig-
nificant occupational health and safety (OHS) issue. As this unit 
focuses on using the computer to create and use spreadsheets, we 
need to be aware of the design of the office environment and the 
individual workstation.
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It is recommended that you consider the following to prevent OHS 
issues when operating computers at workstations within an office 
environment:

	➤ style of workstation or desk, depending upon the functions to be 
performed.

	➤ workstation or desk heigh.t

	➤ placement of workstation within the office.

	➤ placement of keyboard to align with computer monitor and body, 
mouse and computer monitor, in-out tray, and other equipment 
regularly used.

	➤ computer monitor stand, wrist or forearm rests or document holders, 
and their placements.

	➤ placement of storage facility for items needed to be accessed 
regularly,such as training manuals, paper, envelopes, pens and so on.

	➤ placement of necessary filing cabinets.

	➤ adequate leg room underneath workstation or desk.

	➤ footrest.

	➤ lighting, including optimum lighting for the required task(s), 
reduction of glare and reflections from work surfaces.

	➤ noise of nearby equipment or machinery.

	➤ provision of privacy and place to talk without interrupting others.

	➤ air quality, temperature, including impact from heating/cooling 
vents.

	➤ adjustable chair to provide proper support and height.

	➤ telephone headset for frequent use.

	➤ cabling protection.
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Look at the following checklist and answer the questions about 

your current workstation.

Checklist Yes No

Do you have an individual workstation?

Is there enough space around your furniture to gain access to 
the workstation and move around it comfortably?

Is your desk large enough to accommodate all your work?

Is your desk at the correct height?

Is your chair comfortable and able to be adjusted?

Is your computer screen at a comfortable reading distance?

Is the height and angle of your monitor correct?

Is there sufficient space to move your mouse effectively?

Is the keyboard angled correctly?

Do you have to twist your neck to see your work?

Are document holders available?

Can you place your feet on the floor or is there a footrest 
available?

Is the monitor clean and the image stable?

Does your monitor reflect glare from windows and other 
objects?

Is the lighting satisfactory, not too bright or too dull?

Many employees spend most of their day using the computer. It is 
essential that correct posture is maintained throughout the day to 
avoid muscle or joint strain.

Developing touch-typing skills helps to reduce strain in moving the 
head frequently in order to look at the keyboard, particularly when 
typing from a document.
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When typing, you should ensure that your fingers are curved over the 
keyboard with each of your thumbs over the spacebar. Wrists should 
not be raised and elbows should be alongside your body.

At your workstation, you should exercise frequently to prevent injuries 
from overuse. Be mindful of wrists, arms, shoulders, neck and head, 
taking adequate breaks from repetitive tasks, such as using a keyboard 
and mouse.

Eye strain is also a common problem when working at the computer 
for long periods of time. Look away from the monitor frequently to give 
your eyes a rest.Blinking often will stop your eyes from drying out.

If ergonomic requirements are not considered, then a worker could 
suffer all, or any of the following:

	◗ aggravation of an existing injury or illness.

	◗ neck, shoulder, back, or repetitive strain injury.

	◗ eye strain or damage.

	◗

Poor posture causes pain
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It is the responsibility of each individual to position their computer 
and keyboard to reduce the possibility of workplace injury.

Tick off the following to ensure that your computer and keyboard are 
correctly positioned.

Arrange your work area so that you are directly facing both the 
computer and keyboard. This avoids unnecessary twisting and 
turning.

The monitor should be at eye level when sitting. Check to see 
you are looking directly at the top line of the screen. This reduces 
the chance of stressing your neck muscles.

Place monitor at arm’s length away from you to reduce visual 
fatigue.

Tilt your screen to reduce glare.

Provide enough workspace for the keyboard, mouse, and other 
attachments so you are able to move about freely without 
bumping into things.

Adjust your chair so that the keyboard is at elbow level. Your 
forearms,wrists and hands should be in a straight line parallel 
to the floor as you type.

The ergonomics of your workplace
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You are required to adjust your workspace, furniture and quipment 
every time you use the computer facilities. You will be observed 
and assessed throughout this course on your ability to consistently 
demonstrate appropriate ergonomic practices.

          Conservation techniques

Environmentally sustainable work practices are procedures 
adopted within a work environment that contribute to a 
reduction in the use of the earth’s limited resources. It is 
generally accepted that we must conserve and manage these 
resources for our own needs so that we do not compromise the 
ability of future generations to meet their needs.

Some states and countries will have laws that apply to large cor-
porations. There may also be laws that relate to specific industries 
which ensure that materials are disposed of appropriately.

Organisations will also have policies and procedures in place to 
minimise wastage. For example, some businesses will have pol-
icies for the shredding of paper or the correct disposal or recy-
cling of consumables.

Vodafone Qatar is proactive in promoting environmentally sus-
tainable work practices.

Read the following advertisement to see one way in which it is 
pursuing its environmentally sustainable ideals.
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What can businesses do to respond to conservation issues?

	◗ Use of email instead of printing and mailing correspondence

	◗ Water conservation

	◗ Paper recycling – prepare note pads from scrap paper`

	◗ Make double sided paper copies where possible

	◗ Shredding of confidential waste paper for recycling

	◗ Return of mobile phones

	◗ Recycling of printer cartridges

	◗ Use of energy efficient lighting

	◗ Electronic filing and archiving

	◗ Use of power-saving options and stand-by functions on office 
equipment.
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	◗  Turning office equipment off at power source when not in use.

	◗ Car pooling.

Read the following article to see what other procedures Vodafone 
Qatar has implemented in support of its environmentally sustainable 
work practices.
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Practice

Activity 1  

List the practices you believe could be implemented here at 
school to assist with conservative techniques.

...................................................................................................................

...................................................................................................................

...................................................................................................................

...................................................................................................................

...................................................................................................................

...................................................................................................................

...................................................................................................................

...................................................................................................................

...................................................................................................................

...................................................................................................................

...................................................................................................................

...................................................................................................................

...................................................................................................................

...................................................................................................................
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Task requirements
 

Often, supervisors will require a task to be completed by the 
employee. However, the supervisor may not provide specific or 
detailed instructions that will enable the employee to complete 
the task.

If this is the case, the employee will have to use appropriate 
questioning techniques in order to find out what key information 
is required to be able to perform the task.

The employee may have to consider who will be the best person 
to answer their questions. An organisational chart may have to be 
consulted in order to determine the most appropriate person to 
ask.

With spreadsheets, we may need to ask specific questions, such as:

	➤ What is the purpose of the spreadsheet?

	➤ What program is to be used?

	➤ What data, numbers or text has to be entered?

	➤ What is the output requirement and what formulae will be 
required?

	➤ How is the data to be presented?

	➤ Will the presentation of charts be necessary?

	➤ How and where will the data be stored?
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Create simple spreadsheets

Entering data into a spreadsheet  

Once you have selected and prepared the resources you need to 
commence creating your spreadsheet.

We first need to understand a number of basic concepts associated 
with spreadsheets.

A spreadsheet is actually a worksheet which is part of a workbook. 
If you look at the bottom left hand corner of the page you will see 
that ‘Sheet 1’ is highlighted.We can use and save any number of 
sheets, which will then form part of the one workbook.

You will also see that there are numbers down the left hand column, 
and letters across the top of the page. The numbers on the left, 
correspond to the rows across the page, and the letters at the top 
correspond to the columns appearing vertically. This is essentially 
a grid reference system, which uses these numbers and letters to 
determine the exact location of a cell.
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When you open a worksheet, the box at the top left hand cor-
ner should be clearly highlighted – that is the active cell, and is 
called ‘A1’ as it appears at the junction of the number 1 row and 
number A column. As you move between cells, the highlighted 
cell is the ‘active’ cell, and its reference appears in the left hand 
panel below the toolbar or ribbon.

Practice

Activity 2

Look at the following worksheet.

What is the location of the active cell?

...................................................................................................................

What is the name of the worksheet?

...................................................................................................................
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You can move between cells by using your mouse, left-click to 
activate a cell, or by using the Tab key. You should note that some 
manuals will tell you to press ‘Enter’ to secure data in the active 
cell and move to the next, and other programs will tell you to 
record data and then move to the next cell by pressing the Tab 
key. Provided that the correct data appears in the cell once you 
move to the next active cell, it does not matter which method 
you use to enter the data.

We will now practise working with a spreadsheet. Open excel and 
create a new worksheet and enter the data below. The data consists 
of both text and numbers.

Spreadsheets consist of rows and columns of numeric data. 
Mathematical calculations are performed upon this data. It 
is therefore most important that the data entry has to be 
completely accurate if the results of the spreadsheet are to 
be relied upon.
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To enter the numeric data, engage the number lock at the right 
hand side of your keyboard and use the numeric keys in that section 
or use the numeric keys located above the alpha keys in the main 
section of the keyboard.

Identify the differences in the following worksheet and make the 
changes to the spreadsheet you have already created.

We have seen how important it is to identify the task requirements 
and how you may need to consult an organisational chart to de-
termine who the most appropriate person is to assist you with en-
quiries.

It is equally important to be aware of the organisational require-
ments in preparing spreadsheets. There may be a number of style 
and presentation requirements you would need to meet in order 
to satisfy organisational procedures. For the purposes of this unit, 
we will assume the following procedures should be followed at all 
times, unless otherwise stated.
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	◗ Spreadsheets to be named ‘drive\BSBITU304A\document_title\date’.

	◗ Spreadsheets to be printed showing gridlines and row and column 
headings.

	◗ Always preview your spreadsheet before printing to ensure you 
do not waste paper. Make sure the gridlines and row and column 
headings are showing.

	◗ Print your document but take care to make sure you only print a 
particular sheet or selection of a worksheet.

	◗ Save your work using correct protocol.

	◗ Amend your spreadsheet to correct any data entry or calculation 
errors.

	◗ Save your corrected work or ‘save as’ a different file name.

You can create simple spreadsheets 
to calculate the net profit of sales

Formatting a spreadsheet using software functions

We have seen how important it is to identify the task requirements and 
how you may need to consult an organisational chart to determine 
who the most appropriate person is to assist you with enquiries.
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Practice

Activity 3

You are employed by the stationery division of an organisation, 
and the manager wants you to calculate which of its pen prod-
ucts is the most profitable. The purpose of this spreadsheet is to 
calculate the net profit received for the sale of Super 6 pens over a 
period of six months.

Spreadsheet data:

	◗ In January, the division sold 20 pens in the first week, 11 in the second 
week, 7 in the third week and 25 in the last week.

	◗ In February, the numbers were 30 in the first week, 22 in the second 
week, 11 in the third week and 29 in the last week.

	◗ The numbers for March were 28 ,19 ,8, and 22; for April were 21,10      
6, and 18; for May were 15 ,9 ,15, and 18; and for June were 16,22 ,20, 
and 21.

	◗ Each pen sells for 15$ and the cost to the division for acquiring each 
pen is $ 7.

Data entry: 

So how do we go about this? Follow the steps in order.

Step 1

Open a new workbook.
Step 2

In the A1 cell enter ‘Super 6 pens’.
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Step 3

In A2 enter the word ‘Month’, in A3 enter ‘Week 1’, in A4 enter ‘Week 
2’, in A5 enter ‘Week 3’ and in A6 enter ‘Last week’.

Step 4

In B2 enter January, in C2 enter February, in D2 enter March, in E2 
enter April, in F2 enter May, and in G2 enter June.

Step 5

Then you have to enter the number of pens sold.

1 A B C D E F G
2 Month January February March April May June

3 Week 1 20 30 28 21 15 16

4 Week 2 11 22 19 10 9 22

5 Week 3 7 11 8 6 15 20

6 Last week 25 29 22 18 18 21

Step 6

Now we are going to total the number of pens sold in each month.
First, enter the words ‘Month total’ in A7, and then enter the follow-
ing formulae:

	➤ in B7 ‘=B+3B+4B+5B6’ (eg we are directing the program to 
add the amount of pens sold in the first, second, third and 
last week of January)

	➤ in C7 ‘=C+3C+4C+5C6’

	➤ in D7 ‘=D+3D+4D+5D6

	➤ in E7 ‘=E+3E+4E+5E6’
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	➤ in F7 ‘=F+3F+4F+5F6’

	➤ in G7 ‘=G+3G+4G+5G6’.

	➤ All totals for the month should now show as ,55 ,77 ,92 ,63 
57 and 79.

Step 7

The next step is to calculate the monthly sales value, at 15$ per 
pen:

	◗ In A9 please enter the words ‘Total sale price’, then enter the 
following formulae:

	➤ in B9 enter ‘=B15*7’ (eg we are directing the program to 
multiply the total number of pens sold in January by the sale 
price of 15$)

	➤ in C9 enter ‘=C15*7’

	➤ in D9 enter ‘=D15*7’

	➤ in E9 enter ‘=E15*7’

	➤ in F9 enter ‘=F15*7’

	➤ in G9 enter ‘=G15*7’.
The total sale price for each month should now show as 945, 
1,380, 1155,825, 855 and 1,185.

Step 8

Now let’s add the total value of sales for the six month period by 
inserting the words ‘Total sale price for period’ in A11, and then in 
G11 entering the formula ‘=B9+C9+D9+E9+F9+G9’ (eg we are di-
recting the program to add the value of pens sold for the months 
of January to June, both inclusive).

The value of the total sales should now be shown as $6,345.
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Step 9
We discover that we have made an error. Before we calculated the 
value of the total sales, we should have calculated the cost of buying 
the pens in order to arrive at a net profit figure. Do we have to do 
this all over again, or is there another way?

Fortunately, we can use the program to make most calculations, so 
this time we do not need to start from the beginning.

We know that the purchase price of each pen is 7$. So first we need 
to add up the total number of pens for the period in question.

In A13 insert the words ‘Total number of pens’, and then in E13 
insert the formula ‘=B+7C+7D+7E+7F+7G7’ (eg we are directing the 
program to add up the total number of pens sold for each month).

The number shown should be 423.

Then in A14 insert the words ‘Total cost of pens’, and in E14 insert 
the formula ‘=E7*13’ (eg we are directing the program to multiply 
the total number of pens for the period by the purchase price of 7$).

In E14 the total acquisition cost should be shown as $2,961.

Step 10

So now we know that the total amount the division received for the 
Super 6 pens during the period was 6,345$ (G11), and the total costs 
for the Super 6 pens sold in that period was 2,961$ (E14). How do we 
then ascertain the net profit?
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In A16 insert the words ‘Net profit for period’, and then in H16 
insert the formula ‘=G-11E14’ (eg we are directing the program 
to deduct the total cost of the pens for the period as shown in 
E14, from the total sale price of the pens for the period as shown 
in G11).

The amount shown in H16 should be 3,384$.

Step 11

Your employer has decided that to calculate the true profit, a 
percentage of 2% should be deducted for handling and freight 
costs.

So how do we do this?

We could multiply the net cost by 2% and then deduct that 2% 
from the total, or we could simply multiply our total by 98% to 
arrive at the true profit figure.

Therefore, in A18 please insert the words ‘True net profit 
after deduction of 2% handling’, and in I18 insert the formula 
‘=H%98*16’ (eg we are directing the program to find 98% of the 
amount in H16).

The figure shown should be 3,316.32$.

Step 12

You have now completed Sheet 1 in your workbook. Save that 
workbook by using the designated naming and storing require-
ments.
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Step 13

Print Sheet 1, using the designated preview/printing requirements, 
and place your printed work in your portfolio.

Step 14

Please turn to Activity answer 3 at the back of this workbook to 
check your spreadsheet and take a rest break.

Practice

Activity 4

Unfortunately, your employer provided you with some incorrect 
data and the spreadsheet previously prepared has to be amended.

However, just in case he or she decides that the original data was 
not an error, we will decide to be prudent and retain the previously 
saved spreadsheet just in case.

 
Spreadsheet data:

	➤ Week 1 sales for March should be 15, the last week’s sales for 
Mayshould be 22 and June’s sales for week 2 should be 20..

Data entry: 

Retrieve the spreadsheet you have just completed.

Follow the steps in order to insert your information into another 
sheet andthen correct the data.
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Step 1

With your mouse, using click and drag techniques, highlight all of 
the cells from and including A1 to I18.

Step 2

Copy the selection of cells and paste the selection into Sheet 2.

Step 3

In D3 change 28 to 15, in F6 change 18 to 22, and in G4 change 22 
to 20.
You will notice that all of the cells in which formulae have been 
inserted will automatically re-calculate.

Step 4

However, we have not finished yet. Your employer has decided that 
the handling allowance should be %3 instead of 2%.

Step 5

Please alter cells A18 and I18 accordingly.

Step 6

Check that your work is the same as Activity answer 4 at the back of 
this workbook.

Step 7

Save your work.
Step 8

Review and print Sheet 2 for inclusion in your portfolio.

Step 9

Check that you have the original Sheet 1, and your new Sheet 2, 
in your workbook, exit the spreadsheet application and take a rest 
break.
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Practice

Activity 5

You now have to re-name and colour your sheets, and then print 
them using the print option facility.

Spreadsheet data:

Sheet 1 is to be renamed ‘Original Data Super 6 pens’ and sheet 2 is 
to be renamed ‘Updated Data Super 6 pens’. Both new sheet names 
are to be coloured.

Data entry: 

Re-open your spreadsheet application, and then re-open the 
sheets you created in the previous two activities. Follow the steps.

Step 1

Make sure your active sheet is Sheet 1. Double left click on the ‘Sheet 
1’tab in the bottom left hand corner. Over the words ‘Sheet 1’ enter 
Original data Super 6 pens.

Step 2

Move to Sheet 2. Double left click on the ‘Sheet 2’ tab in the bottom left 
hand corner. Over the words ‘Sheet 2’ enter ‘Updated data Super 6 pens’.

Step 3

Return to ‘Original data super 6 pens’, right click and colour the tab.
Repeat and use a different colour for the tab for ‘Updated data Super 
6 pens’.
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Step 4

Check that your work matches Activity answer 5.

Step 5

Go into Print preview, then Setup, then Header/Footer, Custom header,
and in the centre section type ‘Original data Super 6 pens’, then 
‘OK’twice. Check that the print preview matches Activity answer 5.

Step 6

Print a copy of your ‘Original data Super 6 pens’ sheet, and include this 
in your portfolio.

Step 7

Repeat these actions in respect to ‘Updated data Super 6 pens’, make
sure you save your amendments, print a copy for your portfolio and 
then take a rest break.

Practice

Activity 6

You now have to format your spreadsheet by merging cells, 
centringheadings, expanding column widths and changing the 
page orientation.

Spreadsheet data:

‘Updated Data Super 6 pens’ is to be formatted into a new sheet, 
renamed‘Formatted updated data Super 6 pens’ and with the tab 
coloured.
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The heading, Super 6 pens is to be merged and centred.

Column A is to be expanded.

Both new sheet names are to be coloured.

Data entry: 

Re-open your spreadsheet application, and then open the sheets 
you created in the previous activities. Follow the steps below.

Step 1

Open your ‘Updated data Super 6 pens sheet’, and then copy and 
paste it into Sheet 3.
Rename Sheet 3 as ‘Formatted Super 6 pens sheet’.

Step 2
We will now change some attributes in your sheet:

	➤ Go to cell A1, click and drag across to I1. In the Home tab and 
in the alignment section of the ribbon, click on ‘merge and 
centre’.

	➤ Then in B25 type the total net profit figure of 3197.12, then in 
A25 type ‘Total net profit Super 6 pens’ and press ‘Enter’.

	➤ You will see that all of the words in A25 are not visible in the 
cell (although you can see them in the top right hand panel).

	➤ Whilst the active cell is A25, please go to Format Cells (right 
click), Alignment, click ‘Shrink to fit’ and ‘OK’. You will now be 
able to see all of the words in A25.

Then with your mouse, click on the junction of A and B, and move 
the cell divider to the right until you can see the words in A25 in 
normal size.
Column I is now located on page two of the sheet, and will appear 
on a separate page when printed!
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Step 3

You will need to make some changes to ensure that all of the figures 
appear on the one page. We have a number of options:

	➤ Go to Print or Print preview, find the Page setup, and set 
orientation to Landscape.

	➤ Alternatively, you could go to Print or Print preview and 
‘shrink’ to fit to one page. All components of the sheet will 
then print on the one page.

Step 4
Check that your work is the same as Activity answer 6.

Step 5
Print two copies using each of the methods above. Print one copy 
using landscape orientation and print another copy by shrinking 
and ‘fit to one page’ on portrait. Save your changes, include both 
printed sheets in your portfolio and take a rest break.

Use and testing of formulae to meet task requirements

It has been noted previously how important it is to enter data 

correctly. The same applies to entering formulae. Entering ncorrect 

formulae will trigger an error response from the software or will 

produce incorrect results.

One way of checking the formula is to highlight the cell containing 

the formula and look at the panel under the toolbar. This will 

indicate exactly what formula is being used in that cell.
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Practice

Activity 7

You now have to re-name and colour your sheets, and then print 
them using the print option facility.

Spreadsheet data:

Create a new sheet.

Enter the following numbers in cells A1, B1, C1 and D1 – 235, 226, 
273, 274.

Data entry: 

Open the spreadsheet file we have been working on and then fol-
low the steps.

Step 1

When you opened your new workbook, this should have opened
automatically with three sheets. The first thing we are going to do 
here is to create a new sheet in your existing workbook:

	➤ Click on ‘Insert’ and then ‘Worksheet’.

	➤ Using your mouse and the left click function, and the small 
arrow which will appear above the pointer, drag the new 
sheet to the right of your ‘Formatted updated data super 6 
pens’.

	➤ Then using the steps you followed in previous learning activities, 
rename that sheet ‘Checking formulae’ and colour code.
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Step 2

Type the following data in your ‘Checking formulae’ sheet:
	➤ in A1 insert the figure 235, in B226 1, in C273 1, in D274 1

	➤ in B3 insert the formula ‘=A+1B+1C+1D1’

	➤ in B5 insert the formula ‘=A+1B+1C1’.

	➤ in B7 use the comparison operator formula ‘=B3=B5’, to find out 
whether in fact B3 does equal B5.

Step 3

Then go to Formula, Formula auditing and activate ‘Show formula 

auditing toolbar’.
	➤ Activate cell B3, and then on the toolbar click on ‘Trace precedents’. 

You can see that the program then links B3 with the four cells 
which provided data for the formula.

	➤ Then activate cell B5, and again click on ‘Trace precedents’. Again, 
the program links B5 with the three cells which provided data for 
the formula.

	➤ Then if you trace the precedents for cell B7, you will see that this 
is also linked.

	➤ Leaving the arrows as they appear, preview and then print this 
sheet, and include the printed sheet in your portfolio.

Practice

Activity 8

You are still employed by the stationery division of an organisation, 
and you have now been asked to prepare a spreadsheet for one of 
the other pen products sold by the division, the Slick 7.
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The purpose of this spreadsheet is to enable the division to compare 
the net profit received from the sale of each line of pens – Super 6 
and the Slick 7.

Spreadsheet data:

	◗ In January, the division sold 9 pens in the first week, 8 in the second 
week, 13 in the third week, and 21 in the last week.

	◗ In February, the numbers were 20 in the first week, 28 in the second 
week, 8 in the third week, and 39 in the last week.

	◗ The numbers for March were 9 ,16 ,15, and 18; for April were ,17 ,19 
7, and 21; for May were 10 ,19 ,10, and 12; and for June were ,15 ,13 
18, and 31.

Data entry: 

Step 1

Open a new sheet in your existing workbook, and name the sheet 
‘Data Slick 7 pens’.

Step 2

Include appropriate descriptors in all applicable columns and rows.

Step 3

Enter the data above.

Step 4

nter the necessary formulae to calculate the total pens sold in each
month.

Step 5

Enter the necessary formula to calculate the total number of pens sold
over the six month period.
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Step 6

Enter the necessary formula to calculate the net profit for the total six
month period where each pen sells for 14$, and the cost of purchasing
each pen is 6$.

Step 7

Then enter the necessary formula to adjust the total net profit, taking 
into account handling costs of 1%.

Step 8

Apply shading to all cells which contain written descriptors.

Step 9

Include an appropriate header in your worksheet.

Step 10

Print your worksheet, including row and column headings but not 
gridlines, and include that worksheet in your portfolio.

Step 11

Save your work and exit the spreadsheet application, and take a rest
break before moving to the next section.

Use of manuals and online help

When you experience problems in working with spreadsheets, there 
are many ways in which you can get assistance.

The Help function in excel is very good. You can search under 
headings or you can use the search tool. See the offline Excel Help 
screen below.
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You can also search online for assistance with Excel.

Comprehensive user manuals are also available. These provide a 
useful resource for users of spreadsheet applications.

Many employers will also provide employees with organisational 
procedures, specific user documentation, style guides and 
presentation requirements.
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Practice

Activity 9

Using the online Help function, write a brief description of how to do 
the following.

How do you add or remove worksheet columns?

How do you add headers and footers to worksheets?

How do you change the number formatting?

How do you save a workbook in another file format?
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Produce simple charts

Selection of chart type to meet task requirements

You can produce simple charts 
based on your spreadsheet data.

Now that you have completed entering data into a spreadsheet 
you can now use that information to produce a simple chart.

Charts are used for many purposes.

One purpose is to demonstrate the data contained in a spread-
sheet, or in some other document, in a more visual way in order 
to increase its impact.

For example, if a colleague told you that in January this year his 
or her department sold 32 cars, but in each month since then 
the department had sold two cars less than the month before, or 
handed you a spreadsheet with the figures, you would hear the 
information, but it may not have a lot of impact. You might think, 
‘Oh well, business is slowing down a little, that’s too bad’. How-
ever,if your colleague presented you with either of the following 
charts, you might view the information in a different way.
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Bar chart showing cars soldPie chart showing cars sold

Bar chart showing quarterly 
results by region

	➤ Charts can be presented in many different ways, and the type of 
chart will often depend upon the business or organisation and 
the target audience.

	➤ Let’s use our cars again as an example, and add the element 
of cars being returned because of defects. The chart could be 
presented as follows.

Three dimensional chart showing cars sold and defect returns
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Bar chart showing cars sold and defect returns

	➤ These are only some of the types of charts we can choose from, 
with some other selections being scatter, bubble, line, pie or 3D 
pie.

	➤ In all cases, the type of chart will be dependent upon the nature 
of the business and the target audience.

	➤ For example, some businesses or organisations might prefer 
very ‘sedate’ types of charts, such as the first two charts we 
included; whilst others will prefer those which provide significant 
visual impact. Some audiences might easily understand very 
complicated charts, whilst others will become lost in the detail if
they are too complicated.

	➤ In Excel, go to the Insert tab and look at the different types of 
charts that are available. Click on the Other charts icon to see 
other available chart designs.
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Practice

Activity 10

After viewing these charts, select three different types and in 
the following table write down in what circumstances (types 
of presentation / industry /audience) you think these could be 
used.

Type of chart Use of chart

Use of manuals and online help
 

Charts are most commonly created within a spreadsheet based 
upon the spreadsheet data.

Depending upon the task requirements and how the work is pre-
pared, this can result in information being provided in a manner 
which combines statistical information (spreadsheet data), with 
visual information (chart).
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Practice

Activity 11

You now work at Hussain’s shop. Hussain wants to approach his 
local bank for a loan so that he can expand his business. At the 
moment,Hussain sells computers, printers, and printer toner 
cartridges, and wants you to prepare a spreadsheet showing his 
sales figures for the past 12 months.

Hussain thinks that a chart will emphasise the point that his sales 
are steady and instructs you to include a chart in the spreadsheet 
you are preparing based on his sales figures. Hussain does not 
specify what type of chart he wants.

Spreadsheet data:

	◗ Computer sales for the 12 months (January – December):
	➤ 9 ,4 ,5 ,9 ,8 ,11 ,12 ,13 ,10 ,7 ,8 ,11.

	◗ Printer sales for the 12 months (January – December):
	➤ 20 ,15 ,12 ,11 ,12 ,13 ,15 ,17 ,16 ,17 ,21 ,22.

	◗ Toner sales for the 12 months (January – December):
	➤ 25 ,12 ,21 ,19 ,18 ,19 ,21 ,23 ,22 ,26 ,19 ,20.

Data entry: 

Work through the following steps to create the spreadsheet:

Step 1

Open a new workbook.
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Step 2
In Sheet 1, enter the following data:

	➤ in column B insert the following figures in rows:  2 -13 ,9 , 4,5  
9 ,8 ,11 ,12 ,13 ,10 ,7 ,8 ,11

	➤ in column C insert the following figures in rows ,20,15,12 :13 – 2 
22 ,21 ,17 ,16 ,17 ,15 ,13 ,11,12

	➤ in column D insert the following figures in rows ,12 ,25 :13 – 2 
20 ,19 ,26 ,22 ,23 ,21 ,19 ,19,18 ,21

	➤ in B14 insert the calculation required to add all of the 
numbers in A2 – A13

	➤ in C14 insert the calculation required to add all of the 
numbers in B2 – B13

	➤ in D14 insert the calculation required to add all of the 
numbers in C2 – C13.

Step 3
Label A1 as ‘Sales’, B1 as ‘Computer sales’, C1 as ‘Printer sales’, and D1 
as ‘Toner sales’. Use your mouse to click at the top of each column and 
drag the right hand border so that all of the words in B1, C1 and D1 
appear in full.

Step 4
Commencing at A2, insert ‘Jan’, ‘Feb’ to ‘Dec’ down that row, and the 
word ‘Totals’ in cell A14.

Step 5
Insert a blank row before the totals so that the totals now appear in
row 15.

Step 6
then to ‘Custom header’. In the centre section insert the words ‘Hussain’s 
shop’, increase the font to Arial 12, and underline these words.
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Step 7
Rename that sheet ‘Hussain’s Shop Sales’.

Now we are ready to insert a chart.
In order for the program to prepare a chart based on the figures 
contained in your spreadsheet, you have to instruct the program 
accordingly, and you can do this by highlighting cells A1 – D13 in 
your spreadsheet.

Work through the following steps to create your chart.

Step 1
Click on the Insert tab, select a ‘-3D column’ chart.

Step 2
The chart appears on screen in a text box. With your mouse, move the
chart directly underneath the spreadsheet.

Step 3
Click the Layout tab and select ‘Chart title’ and then ‘Above chart’. In the 
text box that appears, insert the words ‘Sales – January to December
over the top of the words ‘Chart title’.

Step 4
Check to see that your work is the same as Activity answer 11.

Step 5
Save your work and print a copy to add to your portfolio.

Step 6
Repeat the process and experiment to see what other graphs look 
like.
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Practice

Activity 12

Hussain has reviewed the previous spreadsheet and chart you 
prepared.

Some figures are incorrect and need to be changed, and he 
would also like you to change the type of chart presentation to a 
3D line chart.Hussain does not want gridlines, or row and column 
headings shown in the printed spreadsheet.

He needs the updated spreadsheet and chart quite urgently, as 
he has an appointment with the bank manager tomorrow.

Assuming you saved your data and correctly exited the applica-
tion in the previous activity, you will be able to retrieve your orig-
inal spreadsheet data (and chart).

Spreadsheet data:

	◗ Changes to computer sales:
	➤ October change from 7 to 11
	➤ November change from 8 to 12.

	◗ Changes to printer sales:
	➤ January change from 20 to 18
	➤ July change from 15 to 16
	➤ October change from 17 to 20.

	◗ Changes to toner sales:
	➤ November change from 19 to 22

	➤ December change from 20 to 24.
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Data entry: 

Work through the following steps to create the spreadsheet.

Step 1

Re-open your spreadsheet application, open your ‘Hussain’s Shop’
workbook, and copy your spreadsheet data to Sheet 2.

Step 2

Rename Sheet 2 as ‘Hussain’s Shop Sales revised date’, and make the
following data amendments:
B11 change 7 to 11, B12 change 8 to 12, C2 change 20 to 18, C8 
change15 to 16, C11 change 17 to 20, D12 change 19 to 22, D13 
change 20 to 24.

Step 3

Prepare and include a 3D line chart in your spreadsheet based on 
the revised figures.

Step 4

Review your revised spreadsheet and chart, and ensure that gridlines 
and row and column headings will not be shown on printing, and 
ensure that the spreadsheet information and chart are neatly set out 
on page 1.

Step 5

Print a copy of your revised spreadsheet and chart for inclusion in 
your portfolio.

Step 6

Save your work and exit the spreadsheet application.
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Practice

Activity 13

Hussain failed to obtain his additional finance, and you are now 
working on a part-time basis. You are also again working for the 
stationery division of an organisation on a part-time basis. The 
manager of the stationery division is aware that you can prepare 
charts and has asked you to prepare some charts for the spread-
sheets you have previously prepared.

Spreadsheet data:

Spreadsheets for the Super 6 and the Slick 7 pens.

Data entry: 

Open your spreadsheet application, and return to the spreadsheets 
you previously prepared (‘Formatted updated data Super 6 pens’) 
and (‘data Slick 7 pens’), and then carry out the following.

Step 1

Copy the spreadsheets into a new workbook, into two sheets.

Step 2

The new workbook is to be saved and stored using the naming and storing 
conventions and is to be named ‘Super 6 and Slick 7 pen omparison’.

Step 3

Sheet 1 is to be used for the Super 6 pen data, and is to be renamed
‘Super 6 pen data’; Sheet 2 is to be used for the Slick 7 pen data, and 
is to be renamed ‘Slick 7 pen data’.
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Step 4

Create a line chart with markers in each of the sheets, using the data 
in those sheets, labelling the charts appropriately.

Step 5

Copy each chart into Sheet 3, and rename that sheet ‘Comparison 
charts Super 6 and Slick 7 pens’.

Step 6

Insert an appropriate header in each of the three sheets.

Step 7

Using ‘Print preview’, implement the organisation’s requirements 
regarding gridlines, and row and column headings in the ‘Super 6 pen 
data’ and ‘Slick 7 pen data’ sheets.

Step 8

Print a copy of all three sheets for inclusion in your portfolio.

Step 9

Ensure your work has been saved, and then exit the application.

Step 10

Back up the ‘Super 6 and Slick 7 pen comparison’ workbook using a 
USB.
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Plan spreadsheet design

You are familiar with the use of spreadsheets and charts. You have 
created spreadsheets, entered data, amended spreadsheets, inserted 
formulae,formatted the presentation of the spreadsheet, produced 
charts, printed and stored. Our spreadsheets have met the specific 
requirements of the task and have included mathematical 
calculations.

Spreadsheet design

We now move on to designing spreadsheets so that other people 
can use them.

When designing spreadsheets, three things need to be taken into 
account.

	➤ What is the purpose of the spreadsheet?

	➤ Who will use, read or enter data into the spreadsheet (audience)?

	➤ What data will be used (information requirements)?Practice

Activity 14

Hussain continues to employ you on a part-time basis. He asks you 
to design a spreadsheet that will assist him with the preparation 
of his daily bank deposits. He is always making mistakes when 
calculating the cash and coins at the end of the day and it 
never equals his cash register totals.

Hussain wants to be able to add up the number of each denomination 
that he has entered it into a spreadsheet and check that the total equals 
the cash register takings for the day.
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Spreadsheet data:

When designing a spreadsheet, we have to plan what it will look 
like, enter formulae and test before we can enter any ‘real’ data. 
Therefore the data will be supplied after we are confident the 
spreadsheet can meet Hussain’s requirements.

Data entry: 

Step 1

Create a new worksheet and name it ‘Daily banking’.

Step 2

In cell A1, enter Denomination. Merge and centre this across cells A1
and B1.

Step 3

In cell A2 type the word Notes and in cell A7 type the word Coins.

Step 4

In cell B2 enter 100$, B50$ 3 and continue down to cell B12 where you 
should enter .05 ) 5c).

Step 5

Format the cell range B2 to B12 for currency and right align all 
denominations.

Step 6

In cell D2 enter the formula B2*C2, using your mouse to insert the 
cell references.

Step 7

Use the Fill handle to copy the formula down to D12.
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Step 8

You will notice 0$ appears in each of the cells. This is because we 
have not yet entered the number of each denomination.

Step 9

In cell D13, enter a formula =sum(d2..d12) to calculate the total of 
all cash.

Step 10

Format the cell range D2 through to D15 for currency with 2 decimals.

Step 11

To check if the spreadsheet is working enter the figure 1 into cells C2
through to C12. The total should appear as 188.85$.

Step 12

The spreadsheet can now calculate the total of the cash deposits 
to be banked daily. However, we have not entered any checks to 
ensure our work is correct. Hussain checks his daily bank deposits 
against his cash register totals each day.

Step 13

In cell A14 enter ‘Enter cash register total’. Centre and merge across 
cells A14 to C14.

Step 14

In cell D15 enter the formula D14 – D13. This will calculate if there 
is any discrepancy between the cash register totals and Hussain’s 
bank deposits.
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Step 15
Enter 185.50$ into cell D14. This indicates that there is a discrepancy 
of 3.35$ between the total that the cash register indicates should be
deposited and how much cash is actually being deposited.

Step 16
Now that we know the spreadsheet is working. Delete the numbers 
you have entered into column C and the amount in D14.

Step 17
Check that your spreadsheet is the same as Activity answer 14, save 
your work using appropriate file protocol and print a copy for your 
portfolio.

Appearance of spreadsheet design

It is important that the design of the spreadsheet meets the purpose, 
audience and information requirements of the task. To be 
appropriate to the audience, the appearance of the spreadsheet 
needs to be considered. We will now make some changes to 
the spreadsheet above to meet organisational requirements as well 
as enhance its presentation to the audience.

Practice

Activity 15

Hussain has been very happy with the way the spreadsheet is 
helping him to calculate and reconcile his daily bank deposits. He 
now wants the spreadsheet to show him his daily deposits for the 
week. He would also like the sheet to be presented so that all staff 
an use it.
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Data entry: 

Step 1

In cell D1 type Sun (Sunday), in F1 Mon, H1 Tue, J1 Wed and L1 Thu.

Step 2

Merge and centre Sun across columns C and D. Repeat for all the other
days of the week.

Step 3

In cell F2 enter the formula B2 * E2 to multiply the denomination by 
the number of units.

Step 4

Use the Fill handle to copy the formula down to F12.

Step 5

Repeat the procedure for columns H, J and L.

Step 6

Enter the total formulae for column F. The formula will be =sum(F2..
F12). Repeat for columns H, J and L.

Step 7

Enter the check formula in column F (F13 – F14) and repeat for 
columns H, J and L.

Step 8

Insert a new row at the top of spreadsheet so that ‘Denominations’ is 
now in B2.

Step 9

Centre and merge across Row 1 ‘Weekly bank deposits’. The heading
should be in bold, Arial and 12pt.
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Step 10

Font size for the rest of the spreadsheet should be in Arial and 10pt.

Step 11

Shade the ranges A2 – B13, D3 – D14, D16, F3 – F14, F16, H3 – H14,
H16, J3 – J14, J16, L3 – L14 and L16.

Step 12

The unshaded cells will be the only cells left ‘unlocked’. Users of the 
spreadsheet will be able to enter data only into these cells. Lock all of 
the shaded cells.

Step 13

In cell H19 type ‘Total of bank deposits for the week’.

Step 14

In cell L19, enter the formula to calculate the total of all daily bank 
deposits, (D+14F+14H+14J+14L14).

Step 15

Check your work against Activity answer 15, save and print a copy 
for your portfolio.

Practice

Activity 16

Hussain now wants to use the spreadsheet for the week 
and get a weekly total of his daily bank deposits.
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Spreadsheet data:

Denomination Sunday Monday Tuesday Wednesday Thursday

$100 5 5 7 3 8

$50 22 28 14 18 29

$20 105 88 95 65 112

$10 85 71 95 58 83

$5 45 56 75 81 76

$2 36 25 42 51 62

$1 25 14 36 41 34

50c 55 28 74 15 36

20c 25 45 72 44 53

10c 22 10 23 21 28

5c 14 12 35 11 24

Daily cash register totals for the week.

Sunday Monday Tuesday Wednesday Thursday

4907.40 4738.60     4800.25 3646.95 5890.60

Retrieve the spreadsheet you have been working on for Hussain and 
enter the data above. Check your work with Activity answer 10. Save 
and print a copy for your portfolio.
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Design and layout

Hussain and his staff are now preparing many documents using 
spreadsheet applications. Because the appearance of each is so 
different, he wants to standardise this by creating style sheets. These 
style sheets will state what size and style headings and column 
headings should be and whether they should be normal, bold or 
italics. Hussain is also considering using some simple macros. He 
also wants to ensure that standard headers and footers and page 
numbering style is used by all staff preparing spreadsheets.

The remaining spreadsheet exercises you prepare must follow a 
standard style guide that you will given.

An example of a spreadsheet with calculations entres
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Finalise spreadsheet

Preview, adjustment and printing

The last task you will need to complete as part of creating a simple 
spreadsheet is to finalise the work.

We have already considered adjusting data in a spreadsheet, and 
have worked through previewing spreadsheets.

We have also considered how the appearance of a chart can 
alter when the underpinning spreadsheet data changes, and 
also how we can select different types of charts which might be 
used in different situations and also, change their appearance.

There is no ‘right way’ to prepare spreadsheets or charts, as what is 
required will depend upon the particular task and organisational 
requirements.

Always preview (print preview) and adjust the spreadsheet prior 
to printing a hard copy. Because the columns and rows are almost 
endless, it is very easy with spreadsheets to waste paper. After 
amending the spreadsheet, preview to ensure it has not moved 
over to the next page.

When finalising your work you may need to preview, adjust or print your
spreadsheet – Remember, you will always need to meet deadlines and manage

your files correctly
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Designated timelines

A designated timeline might include an organisational timeline 
where, for example, information might be required for presenta-
tion to a company auditor, an external customer or client may re-
quire the organisation to produce a spreadsheet or chart within 
a certain time, that is to assist in a presentation to the customer’s 
employees, or it may simply be a timeline set by a supervisor.

If a timeline is set, then of course it must be met; and for this pur-
pose, your teacher may allocate a designated timeline to any of 
your activities or assessment tasks.

An example of a diary which may be used to write down your timelines for your
activities or assessment tasks

Storing spreadsheets

After all the work is done, it is very important to ensure the spread-
sheet is saved and stored correctly. We have already considered or-
ganisational requirements as to file and folder naming protocols. 
You should be following school protocols to save your work in the 
appropriate location.

Passwords on the school computers will ensure unauthorised ac-
cess to your account will not take place. It is important that you do 
not share your passwords with anyone else.
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How often do you back up your files, especially those that you may 
use between school and home? Think about what information 
would be lost if all your files were corrupted. Your files at school 
will be backed up regularly. However, you should ensure your per-
sonal files are backed up frequently. USBs are often used for this 
purpose.

Organisational policy and procedures will ensure that business 
data is protected. Always carefully follow instructions that relate 
to back up of files.

Methods of storage include CD ROM, zip drives, external hard 
drives and USBs.
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Practice activity 
answers

How often do you back up your files, especially those that 
you may use between school and home? Think about what 
information would be lost if all your files were corrupted. 
Your files at school will be backed up regularly. However, 
you should ensure your personal files are backed up fre-
quently. USBs are often used for this purpose.

Practice

Activity answer 1

	➤ Recycling paper.
	➤ Turning off lights when you leave the room.
	➤ Turning off electrical equipment at the end of the day.
	➤ Utilising sleep modes on equipment.
	➤ Flash drives to store data electronically rather than print 
hard copies.

	➤ Use email to send documents rather than print hard 
copies.

Practice

Activity answer 2

	➤ The active cell is C5.

	➤ The name of the worksheet is ‘Blank’.
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Practice

Activity answer 3

	➤ Spreadsheet should be completed as per the following.
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Practice

Activity answer 4

	➤ Spreadsheet should be completed as per the following.
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Practice

Activity answer 5

	➤ Spreadsheet should be completed as per the following.
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Practice

Activity answer 6

	➤ Spreadsheet should be completed as per the following.

Practice

Activity answer 7

	➤ Spreadsheet should be completed as per the following.
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Practice

Activity answer 8

	➤ Spreadsheet should be completed as per the following.

Practice

Activity answer 9

1  � Select the columns to be deleted. Go the ‘Home’ tab and in the‘Cells’ 

group click delete.

2  � Click on the worksheet. Go to the ‘Insert’ tab and in the ‘Text Group’click 

on header/Footer.

3  � Click on the cell or range of cells to be formatted and go to the ‘Cells’tab 

and click on format.

4  � Click ‘Save As’ and in the ‘Save as Type’ click the type of file youwant to 

save.
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Practice

Activity answer 10

Pie graph
Show a break up of different selling expenses

Show a break up of services by type

Line graph
Show the net profit figure month by month

Show the weekly payroll figure

Bar graph
Show departmental expenses

Show the number of employees by department

Practice

Activity answer 11

	➤ Spreadsheet should be completed as per the following.
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Practice

Activity answer 12

	➤ Spreadsheet should be completed as per the following.

Practice

Activity answer 13

	➤ Spreadsheet should be completed as per the following.
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Practice

Activity answer 14

	➤ Spreadsheet should be completed as per the following.
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